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1 Preface 

The SAUTER CASE flexotron user manual applies to the following control systems: 

 Heating control (CASE flexotron Heating) 

 Ventilation control (CASE flexotron Ventilation)  
 

This manual is provided by SAUTER without a guarantee. 

SAUTER may modify or improve this manual at any time and without prior notice. 

All changes will be included in future versions of this manual. 

 

Revision status B, August 2014. 
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2 About this manual 

This manual is intended to help users install and operate CASE flexotron. 

 

It describes all program-specific functions except for the parameters of the 
flexotron800 controller. 

 

 
For these, read the controller manual and use the appropriate application. 

 
The website for the TCP models of the flexotron controller now has a dynamic flow 
chart that changes according to the current configuration. 
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3 Installation 

CASE flexotron can be installed and used with the following operating systems: 

 Windows 2000 

 Windows XP 

 Windows Vista 

 Windows 7 

 Windows 8 

 

In order to use the web versions of the flexotron800,  

 Internet Explorer 7.0 or higher 

 and Java 

are required. 

 

An interface converter (RS485 to USB) is required for the connection. 

 

Installation 

1. Download CASE flexotron from the SAUTER homepage (www.sauter-
controls.com) 

2. Unzip the zip file 

3. Start the setup.exe file located in the unzipped folder 

4. Follow the instructions of the installation program 

http://www.sauter-controls.com/
http://www.sauter-controls.com/
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4 About the CASE flexotron tool 

CASE flexotron Ventilation and CASE flexotron Heating are Windows-based PC 
programs for configuration and maintenance of various controllers of the flexotron800 
series. 

CASE flexotron was not designed to be a complete SCADA program.  

4.1 Program window 

 

 

 

 

 

 

 

 

 

The program window is divided into several areas: 

 The menu bar with Windows-style drop-down menus. 

 The toolbar with direct access to various functions. All the functions of the 

CASE flexotron toolbar can also be accessed via the menu bar. 

 Various tabs Select the tabs to see the folders below them. 

 Status bar. 

 

This manual describes the functions of the various items in the menu bar and the 
CASE flexotron toolbar. The functions are essentially the same for all flexotron800 
applications.  

Because the contents of the folders differ depending on the program, they are not 
discussed in detail here. 

 

 
For more information, see the relevant flexotron800 controller manual. 
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5 Start-up 

 

The installation program creates a folder in the Programs folder of the Start menu. 
This folder contains links to CASE flexotron Ventilation and CASE flexotron Heating. 

 

Starting a program 

1. Click [Start] on the bottom left of the screen 

2. Continue to [All Programs] 

3. Select the SAUTER CASE flexotron folder 

4. Start the program by double-clicking it 

► The program starts 
► An input window appears (with each start) 
► An overview of the models is displayed 

 

5. Select the flexotron800 model in use 

► Be sure to make the correct selection here in order to avoid possible errors 
in the control setting and alarm handling. 
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To make it easier to open the program, you can create a shortcut on the desktop. 

 

Creating a shortcut 

1. Move the cursor onto the program name 

2. Hold down the right mouse button to highlight the program name 

3. Drag the program from the folder to your desktop 

4. Release the right mouse button and complete the process with “Create 
shortcut here” 

 
Creating a shortcut in the taskbar 

When installed in Windows 8, CASE flexotron is stored under “All apps”. “All apps” 
can be accessed from the start screen. 
From here, just click the appropriate icon to start the program. 
 
In addition, you can create a shortcut to CASE flexotron in the taskbar. 

1. To do so, right-click the icon. 

2. Use the toolbar at the bottom of the screen to select “Pin to taskbar”. 

 

When the program is started, it automatically searches for a controller that is 
connected to the computer and also suitable for the loaded program. If no suitable 
controller is found, the program will start offline. 
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6 Menu bar 

The menu bar has five drop-down menus:  

“File”, “Edit”, “View”, “Settings” and “Help” 

6.1 “File” 

 

 

 

 

The sub-menus are used to edit the configuration files.  

The configuration data can be saved as a file. 

Any number of different configurations can be stored. 

The file is saved as one of the following:  

 .vtc for ventilation control 

 .htc for heating control 

and requires approximately 22 KB of hard disk space. 

The files are plain text files and can be opened with regular text editors such as 
Notepad or Wordpad. 

“New” 

“File” > “New” opens a new, untitled file. 

You can select the flexotron800 model in the input window that opens. If you do not 
know the model, you can find the item number on the right side of the controller. 
Make sure you have selected the correct model. If the wrong model is loaded onto 
the flexotron controller, inexplicable alarms and similar errors can occur, because 
functions may be activated that do not exist in the actual model used.  

 
“Open” 

Opens a saved file. 

 
“Save” 

Saves the current file to the local hard disk. If a name has not yet been entered, you 
will be prompted to do so. 

 
“Save as” 

Saves the current file to the local hard drive under a name of your choosing. 

 
“Read only” 

This sub-menu can usually be ignored. However, if for some reason two instances of 
the same file are opened, one will be marked as “Read only” so as to avoid data 
conflicts. 

 
“Print” 

Prints a list with all configuration settings of the current file. 
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“Close” 

Closes CASE flexotron. If the current configuration has not been saved, you will be 
asked if you want to save it before the program is closed. 

6.2 “Edit” 

The “Edit” menu contains one sub-menu: 

 

 
 
“Delete” 

The delete function is only used in connection with holiday periods. It allows the 
entered times to be deleted. 

6.3 “View” 

The “View” menu contains one sub-menu: 

 
 
 
 

 
“Update” 

CASE flexotron is not a dynamic program. If a parameter value has changed in a 
connected controller – the temperature, for example – the corresponding value is not 
automatically updated in the program. The operator must first initiate reading of the 
parameter values from the controller. 

An update then starts reading all dynamic parameters from the controller. The entries 
are updated with the new values. 

If you switch between the tabs, an update starts automatically. 

Alternatively, you can use the update field in the toolbar (see toolbar below) or the F5 
key on the keyboard to start the update. 

The displays can also be updated automatically with dynamic values; see “Options” 
on page 23. 

If the controller software version is older than the CASE flexotron software version, 
they can be adapted to one another. See section 9. 
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6.4 “Settings” 

 

 

 

 

 

 

 

 

 

 

“Load all parameters” 

Download all current parameters from CASE flexotron to the flexotron800 controller. 

 
“Synchronise all parameters” 

All parameters in the flexotron800 are compared with the values in CASE flexotron. 
All differences are listed.  

Settings are usually selected with ticks. You can remove a setting from the selected 
list by removing the tick.  

CASE flexotron can then be updated with the controller values or the controller can 
be updated with the CASE flexotron values. 

 
“Reset all parameters to default values” 

Resets all CASE flexotron parameter values to the default values. 
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“Search for modules” (search for controllers) 
 

 
 

If CASE flexotron cannot establish a connection to a connected controller when it is 
put into service, this is often caused by an incorrect controller address. This function 
scans all possible addresses and address lists to find the controller that is connected 
to the computer. These addresses are then entered in the address field in the 
Configuration/System folder. 

 
“Set module date and time” (module=controller) 

Synchronises the date and time of the controller with the date and time of the 
computer. 

 
“Edit module address” (module=controller) 

This function is used to edit the address of the connected controller. The address is 
usually 254:254. If the controller is to be used in a network, the address must be 
edited because the connected controllers have different addresses. 

 
“Reload module” (module=controller) 

Loads the current controller program from CASE flexotron onto the controller. 
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This function is used to load updated programs to the controller. It can also be used 
for converting from flexotron Heating to flexotron Ventilation or vice versa.  

Here it is important to note that, due to different hardware sizes of the controllers, the 
CASE flexotron program and the flexotron800 model must be compatible with each 
other. 

For example, to load a flexotron RDT815, the corresponding CASE flexotron must be 
set up for the RDT815. Otherwise, unexpected events can occur. 

 
CASE flexotron automatically detects whether the connected controller is a 
flexotron800 or flexotron800 V2. If the controller is a flexotron800, the following 
dialogue box appears, in which you can choose between versions 2.1, 2.3 or 3.2. 

 

If the controller is a flexotron800 V2, the version of CASE flexotron is loaded that 
matches the version installed on the computer. The following dialogue window 
appears: 

 

Click [OK] to load the new controller. The “Synchronize parameters” dialogue 

window is displayed: 
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After the controller has been reloaded with the new application program, the 
following dialogue window appears: 

 
 
“Load website to controller” 

Loads the configuration onto the web server in the flexotron800. A model with 
TCP/IP communication must be used. For more detailed information on this, see 
section 11. 

 

“Update operating system for web server”  
(displayed only for flexotron800 with TCP) 

If the controller is not up to date, we recommend that you update the TCP/IP 
operating system of the controller. 

 
“Log in” 

flexotron800 has four different login levels: 1, 2, 3 and 5: 

 5 is the Basic level with the lowest access 

 3 is the User level with greater access 

 2 is the Service level with even greater access  

 1 is the Administrator level with full access 

CASE flexotron uses only level 3 (User) and level 1 (Administrator).  
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When the flexotron800 is put into service, the following passwords are the defaults 
for the different levels: 

 Administrator 1111 

 Service  2222 

 User  3333 

 Basic  5555 

If a setting is to be made that requires greater access rights than those associated 
with the level being used, it is necessary to change to a higher login level. 

 
“Log out” 

This function is active only when you are logged in as User or Administrator; it allows 
you to log out into the Basic level. 

 
“Change password” 

This function is active only when you are logged in as User or Administrator. It allows 
you to change the password for the current login level. 

 

“Load new default password” 

 

 
 

If vtc or htc files are loaded, it is possible to define new passwords for all levels. The 
files are text files that describe the configuration. The files can be opened with 
Wordpad or Notepad, for example. At the end of the vtc file is the DiaPasswords 
section, which deals with the login codes. 

 

Changing the default password 

1. Open the vtc or htc file 

2. On the “LoadDiaPassWordVisible” line, overwrite the “No” value with “Yes”. 

3. Change the Administrator (1111), Service (2222) and User (3333) levels to 
the desired values. 

4. Save the vtc or htc file 

5. Start CASE flexotron 

6. Import the file 

► If the passwords are to be downloaded, you can click this action (marked 
in red) when loading the parameters onto the flexotron800. 
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“4444” is not used by the controller, and “5555” of the Basic level should not be 
changed. 

“Load new default setting” (Ventilation only)  

 

 
 

If “Yes” was selected for LoadDiaPassWordVisible, you can tick the box (marked in 
red) so save the downloaded parameters as default settings in the controller.  

The values are then used by the function “Reset all parameters to default values ...”.  

Additional information can be found in the flexotron800 Ventilation manual. 
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“Real time chart” 
 

 
 

A real-time trend chart is created with this function. Up to four freely-selectable 
parameters can be recorded. The selected parameters are listed in the box on the 
bottom, along with information on the different colours, the associated scale and the 
most recently stored value.  

The chart has a left and right vertical scale with individually adjustable ranges. The 
horizontal time axis can be adjusted so that shorter and longer time intervals can be 
displayed. 

Using the scroll bar under the chart, you can scroll along the time axis and display 
each position of the recording.  

Values are recorded every 5 seconds. All recorded data can be stored as a text file 
for later use (in a spreadsheet program such as Excel, for example). 

If more than four parameters are to be observed, several sessions of the real-time 
trend chart can run simultaneously. 

 

 
The chart cannot be saved. When you exit the program, all the settings are lost. 
However, you can use the [Print] button to create a screenshot of the current 
diagram and then save that. 
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Real time chart functions 
 

 
 

 “Export” 

Exports all recorded values to a .txt file. The values are separated by tabs for easy 
import into Excel, for example. Each line of the text file contains the values of a 
recording together with the recording time. Recorded data is stored for approx. 24 
hours. 

 

 “Add curves” 

Click this field for a list of all flexotron800 parameters that can be shown in the trend 
chart. Up to four parameters can be selected.  

 

 “Delete all curves” 

Deletes all the selected curves.  

 

 

 

“Show/hide left/right grid” 

The chart grid on the left and right side can be shown or hidden. 

 

 “Show node points” 

Each time of recording can be marked on the curve and displayed. 

 

 “Show cursor” 

Displays a vertical line on the chart. The cursor can be moved along the time axis. 
With an active cursor, the values at the cursor position are displayed, not the most 
recently recorded values. In this way, previously recorded values can be traced.  

 

 “Go to home” 

The home position is the chart position in which the “recording pins” on the right edge 
of the chart are located. If you scroll back along the time line, you can use this 
function to return to the normal starting position.  

 

 “Zoom out” 

Makes the view smaller 

 

 “Pause” 

Stops the chart. Trend recording is stopped; no new values are added to the display. 
However, data recording continues, and new values are stored every five seconds. 
Pressing “Pause” causes all stored recordings to be added to the chart. 
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 “Option” 

Setting of various options. 

 
 

“Time scale” is the time interval shown on the screen.  

“Left scale” determines the scale for the left scale. 

“Right scale” determines the scale for the right scale. 

 

 “Time scale” 

Determines the time interval of the display. 
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Parameter list 
 

 

The parameter list shows the parameters assigned to the chart. To remove a 
parameter, right-click it and select Remove. 

You can reassign the right or left scale by right-clicking Properties or by double-
clicking the left mouse button. 

“Notes” 

Access to the notes area. Each text written here is saved together with the 
configuration file. If the configuration is printed, the note text is included on the 
printout. 

“Options” 

Allows several program parameters to be set. 

 

 
 

It is possible to automatically update the display with dynamic values. 

“Log on timeout” 

After a configurable period of inactivity, the login is reset to the lowest access level. 

“Number of decimals” 

Sets the decimal places displayed. All calculations are carried out with full precision, 
however. 

“Lock configuration” 

Blocks access to the Configuration tab. 

“Also show non-active signals in In/Output tab” 

All inputs/outputs are displayed on the “In/Output” tab. 
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“Synchronize alarm texts when synchronize all” 

During synchronization of all parameters, the alarm texts are also synchronized. 
 

“Temperature/Flow unit” 

Various units for temperature and flow rate can be selected here. 
 
“Communication settings” 

Communication settings between CASE flexotron and controllers. 

The choice of communication depends on the controller model loaded in CASE 
flexotron when it was put into service. Serial communication is the default for all 
models except flexotron800 with TCP. 

 

 
 
Checking communication channels 

1. Click the “Communication channels” button 

2. Select the “Serial” channel 

 

3. Check whether the suggested COM interface matches the interface assigned 
by the computer to the interface converter. 
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Checking the COM interface 

The interface can be checked under “System Settings” > “System” > “Device 
Manager” > “Connections (COM & LPT)”. 

 
TCP/IP communication 

If Case flexotron is opened with a flexotron with TCP, you can choose whether 
communication takes place via USB cable (serial) or TCP/IP interface.  

 

 

 

If the controller has a TCP/IP interface (TCP models), it can communicate via a 
TCP/IP network. 

To do this, activate the “Use a TCP/IP port in this controller” radio button. 

Selecting “TCP/IP, website and e-mail settings” allows you to select between 
three different connection options. 

 Crossover network cable 

 Automatically with DHCP (dynamic IP address) 

 Static IP address 

See section 11 for further setting options. 

 
Crossover network cable 

In these cases, a crossover network cable is used. The user is directly connected 
with the controller.  

1. Connect a crossover TCP/IP cable directly between the controller and the 
computer 

2. Start CASE flexotron 

3. Open the “Communication Settings” function in the “Settings” menu or 
through the icon in the toolbar 

4. Select “Use TCP/IP interface in this controller” 

► The program asks about using a crossover network cable 

5. Confirm with [YES] 

6. The controller search is started. 
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►Since no DHCP is available, a “broadcast” address is used. Therefore, it is 
important that the computer is connected directly to the current controller 
with a crossover Cat5 cable. 

If the search is successful, the IP settings of the controller are displayed: 

 IP address 

 Subnet mask 

 Default gateway (if present) 

If no values are displayed, then: 

1. Select “Search” 

►A browser window opens, the TCP/IP card of the controller is found, and its 
Ethernet address (MAC address) is displayed in the window.  

2. Select a line and press [OK]. 

If no controller is found:  

1. Check the cables and connections 

2. Check that there are no active network connections: “Control Panel” > 
“Network Connections” 

3. Deactivate everything except “Connection to the local network”. 

4. Select “Search” again 

5. Enter the IP address, the subnet mask and, if applicable, the gateway for the 
controller 

6. Select “TCP/IP Settings” for loading.  

If successful, a message is displayed. 

7. Press [OK] 

►A message may appear indicating that a TCP/IP connection has been 
established, but that no controller with the address 254:254 could be found. 
Instead, a controller with another PLA:ELA address was found. 

8. Answer [YES] to the question of whether this controller should be used 
instead.  

The CASE flexotron can now be used for 
configuration/loading/extension/synchronisation and so on. 

 

If the message “Not possible to read the index variables 255:30., QSystem.PLA. not 
responding” appears, there is no connection between the TCP/IP card of the 
controller and the operating system on the motherboard of the controller.  

The reason for this may be an old version in combination with a specific version of a 
component on the TCP/IP card. 

The problem can be solved by loading the latest version onto the controller. 
However, a connection must be established first (a catch-22 situation). A connection 
can be established through repeated restarting and searching. Otherwise, the 
controller must be returned to the factory for updating.  
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Automatically with DHCP (dynamic IP address) 

In this case, select the standard setting “Obtain IP settings automatically (with 
DHCP)”.  

This configuration is appropriate for most networks equipped with a DHCP server, 
and especially when dynamic allocation of IP addresses to the controllers is required.  

The following requirements must be met: 

 The DHCP server and DNS server must co-operate with each other, 
because the controller sends its DNS name to the DHCP server. Windows 
2000 Server, Windows 2003 Server and Windows 2008 Server support this 
feature. This feature is included in most routers. The DHCP server assigns 
an IP address to the controller and registers the IP address or DNS name in 
the DNS server.  

 Each DNS name must be unique.  

 TCP port 26486 must be open from the controller to the host computer. This 
is particularly important if the communication goes through a firewall.  

If the controller and the computer on which CASE flexotron is installed are on the 
same subnet, no DNS name or domain needs to be specified. 

However, if the controller and the computer are on different subnets, a DNS name 
and the domain must be specified. The domain name can be obtained from the 
network administrator.  

 
Static IP address 

In this case, the static IP address is specified by the controller. 

This configuration is best suited for networks without a DHCP server. It can also be 
used if the network service is not fully trusted, because it is communication with the 
best functionality, in contrast to servers.  

As long as routers and switches operate satisfactorily, the alternative configuration 
will also work.  

The following requirement must be met: 

 TCP port 26486 must be open from the controller to the host computer. This 
is particularly important if the communication goes through a firewall.  

The static IP address, net mask and default gateway can be obtained from the 
network administrator. 

6.5 “Help” 

Provides access to manuals, lists of variables and information about the program 
versions. 
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7 Toolbar 

The toolbar provides quick access to selected functions. 

If the cursor is placed on an icon in the toolbar, a brief description of its function is 

displayed. 

All options except for the “Update” function have already been described. 
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8 Folders 

The contents of the various folders depend on the CASE flexotron program (Heating 
or Ventilation) but also on the model (RDT828, RDT815 or RDT808) for which the 
program was configured. 

Therefore, the contents will not be discussed further. 

8.1 General information 

Items in a folder that are associated in some way are grouped together.  

Group names are in bold.  

The groups are usually displayed expanded; that is, all items in the group are 
displayed, and the group name is listed in the first position.  

To collapse a folder, click the - (minus) box to the left of the group name. This causes 
only the group name to be displayed. When a group is collapsed, a + appears in the 
box next to the group name. 

To expand the group, simply click the +. 

 
Setting values 

Many of the folders contain adjustable values. If the cursor is pointing at such a 
value, a text box with the permitted range appears. 

With a flexotron800 connected, a value must be loaded into the controller in order to 
activate it. 

The values can be downloaded into the controller in several ways:  

1. Right-click any item  

2. Select “Load parameter” 

►This causes this particular parameter to be downloaded 
Or: 

1. Right-click a group name  

2. Select “Load parameter” 

►All parameters for the selected group are downloaded 
Or: 

1. Click the “Load all parameters” field in the toolbar 

Or: 

1. Click “Settings” in the menu bar and select “Load all parameters”. 

With the last two methods, all parameters are loaded onto the controller. 

The parameters can also be synchronised as described above. To do this, select 
“Synchronise all parameters”.  

This is a useful feature for comparing the controller settings to those in CASE 
flexotron.  

 

Resetting parameters to default values: 

1. Right-click to select the “Reset all parameters to default values”. 
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8.2 “Overview” tab 

 

 

 

 

 

 

 

 

 

 

 

Most of this tab consists of the start screen or a process diagram. 

The diagram is a static bitmap image that can be created and edited with MS Paint, 
for example. Any number of different diagrams can be saved.  

The diagram displayed depends on the parameter settings for plant schematics in 
the System sub-folder of the Configuration folder. 

A list of the main setting parameters is located on the bottom left in the folder.  

To update these values, you can either use F5 or the refresh function on the toolbar. 

It is also possible to update the display with dynamic values automatically (see 
“Options” on page 23). 
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8.3 “Current/Setpoints” tab 

Displays relevant setpoints and actual values. 

 

 

 

 

 

 

 

 
 
 
 

 
Real-time trend chart 

You can create a real-time trend chart by right-clicking some of the groups. The chart 
is created with the first four parameters recorded in the group. 

8.4 “Consumption” tab  

 
Displayed only with CASE flexotron Heating. 

Displays the consumption values of energy meters, water meters and cold water 
meters. 

The values are calculated using the pulse value that can be set in the Pulse Value 
sub-menu in the Configuration folder. 
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8.5 “Alarm Status” tab 

Allows the alarms to be edited. 

 

 

 

 

 

 

 

 

 

 

The alarm settings can be changed in one of the following ways:  

 By double-clicking the alarm 

 Or by selecting the alarm and clicking Settings 

 Or in the “Settings -> Alarm Settings” folder 

 

 
Changes to the alarm settings must be loaded into the controller for activation. 

 
Alarm display 

The following statuses exist for the alarm: 

 Non-activated alarms are indicated with a green status box. 

 Active alarms are indicated with a red box with a lightning bolt symbol. 

 Alarms that have been reset, but not yet acknowledged, are indicated by a 
yellow box with a lightning bolt symbol.  

 Active acknowledged alarms are indicated with a blue box and a lightning 
bolt symbol. 

 Blocked alarms are indicated with a grey box and a prohibition symbol. 

 

 
 

All alarm status changes in CASE flexotron are immediately transmitted to the 
controller without it being necessary to use the “Load all parameters” function. 

By contrast, alarm status changes in the controller are not displayed in CASE 
flexotron if no update has been carried out. 
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The changes can be tracked at any time using the alarm window in the status bar at 
the bottom of the window. 

 
Alarm classes 
The flexotron800 has three alarm classes: 

 Collective alarm A 

 Collective alarm B 

 Collective alarm C  

A and B alarms activate the digital outputs A-Alarm or B-Alarm, provided they have 
been configured. Both activate the collective alarm output, provided it has been 
configured. 

C alarms are only internal.  

C alarms do not need to be acknowledged. In case of a reset, these alarms 
automatically change back to normal status. 

Alarms can be displayed according to their class: 

 A, B, C or all classes  

 According to status Normal, Blocked, Acknowledged, Back to normal, Alarm 
active and All statuses. 

 
Alarm text in flexotron800 

The alarm text shown in the flexotron800 when an alarm is activated is shown in 
column 2, Alarm text. This text can be changed, but only through CASE flexotron.  

 
Alarm parameters 

Double-click the alarm text to open a field where you can edit various alarm 
parameters, such as alarm texts.  

 

 

 

 

 

 

 

 

 

 

The alarm text, including all spaces, may not be longer than 38 characters, divided 
into 2 lines of 19 characters each.  

If the maximum length on the first line is exceeded by the word on the end, the whole 
word is moved to the second row. 

If you use a hyphen as the 19th character, followed by a space, you can prevent the 
entire word from being moved to the next line. 
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Example: 

“Sensor error Relative Humidity supply air” consists of 40 characters, but, since the 
third word extends beyond the 19th character, the following appears on the display: 

 

 

Sensor error 

Relative Humidity su 

9 Sept 08:52 Class B 

 

If the text is changed to: “Sensor error RH Supply air”, the following appears: 

 

 

Sensor error RH 

Supply air 

9 Sept 08:52 Class B 

 

8.6 “Inputs/Outputs” tab 

Displays current values for all inputs/outputs. 
 

 
 

No changes can be made on this tab (read only). 

Unconfigured inputs/outputs are shown in grey. 
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8.7 “Time Control” tab 

 

 

 

 

 

 

 

 

CASE flexotron Heating  

 Daily comfort times can be set here. 

 Each control function has its own time programme.  

 For each day, there are two periods of use.  

 The 8th day, Public holiday / holiday period, controls the activities on all days 
that are marked as such in the holiday period calendar; see below. 

 The time programmes for Clock channel output 1…5 determine the activation 
of the corresponding digital output signal.  

 To disable a period of use, set the time to 00:00-00. 

 To make the controller run 24 hours a day, set the time to 00:00–24:00. 

 
A period of use cannot be set across midnight. If a period of use of 18:00–02:00 is 
to be configured, it must be divided into two periods of use: Day 1 from 18:00 to 
24:00 and Day 2 from 00:00 to 02:00.  
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CASE flexotron Ventilation 

 Daily operating times can be set here. 

 For single-speed fans, there is only one time programme.  

 With two-speed fans, there are two time programmes. One is for normal 
speed (level 2) and another for reduced speed (level 1). 

 For each day, there are two periods of use. 

 If the running times of the normal speed (level 2) overlap with the reduced 
speed (level 1), the normal speed (level 2) has priority. 

 The 8th day, Public holiday / holiday period, controls the activities on all days 
that are marked as such in the holiday period calendar; see below. 

 The time programmes for Clock channel output 1…5 determine the activation 
of the corresponding digital output signal.  

 To disable a period (period of use), set the time to 00:00-00. 

 To make the controller run 24 hours a day, set the time to 00:00–24:00. 

 
A period cannot be set across midnight. If a period of use of 18:00–02:00 is to be 
configured, it must be divided into two periods of use: 

 Day 1 from 18:00 to 24:00  

 Day 2 from 00:00 to 02:00  
 
Public holiday / holiday period calendar 

 

 

 

 

 

 

 

 

 

 

 Up to 24 different holiday periods and public holidays can be configured. A 
holiday period can be both a single day and up to 365 consecutive days. 

 A holiday period can be created using the Add holiday period field on the 
bottom right. 

 If only a single date is to be selected, just click it and confirm your choice 
with [OK].  

 To mark a period, click the start date, hold the mouse button down and drag 
the cursor to the end date, and then release the mouse button. Then confirm 
your choice with [OK]. Alternatively, you can select the period by clicking the 
start date, pressing the [Shift] key, and simultaneously clicking the end date. 
Then confirm your choice with [OK].  
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 Even if the calendar extends far into the future, holiday periods can be set up 
to one year in advance. If you try to choose a date that is more than 365 
days in the future, the end date will be set to one year from the current date. 

 Click the [Delete] button on the toolbar of CASE flexotron to delete holiday 
times. 

 Set holidays / holiday periods apply each year. They should not be deleted. 
Christmas and New Year’s Eve thus need to be entered only once. 

8.8 “Settings” tab 

 

 

 

 

 

 

Controller settings 

Setting of the control parameters, such as P-band and I-time 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you place the cursor on a parameter value, the setting intervals possible for 
this parameter and the default value are displayed. 

Changes need to be downloaded to the controller before they come into effect. 

To download controller parameters: 

 Either right-click the parameter name or the parameter group name and 
select “Load all parameters”. 

 Or click “Load all parameters” in the CASE flexotron toolbar or in the menu. 
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Alarm settings / alarms 

Setting the alarm parameters. 

The settings can also be performed in the Alarm Status folder. Information in this 
regard can be found in the Alarm status section. 

Unused alarms are removed from the list and saved in the Alarm Status folder. 

Activate A and B/C alarms depending on the configuration of the digital outputs A-
alarm or B-alarm. Both activate the common alarm output (if configured). 

 
Alarm text in flexotron800 

The alarm text shown in the flexotron800 when an alarm is activated is shown on the 
Alarm text line. This text can be changed in CASE flexotron. 

 

The alarm text, including all spaces, may not be longer than 38 characters, divided 
into 2 lines of 19 characters each. 

If the maximum length on the first line is exceeded by the word on the end, the whole 
word is moved to the second row. If you use a hyphen as the 19th character, 
followed by a space, you can prevent the entire word from being moved to the next 
line.  

 
Example: 

“Sensor error Relative Humidity supply air” consists of 40 characters, but, since the 
third word extends beyond the 19th character, the following appears on the display: 

 

 

Sensor error 

Relative Humidity su 

9 Sept 08:52 Class B 

 

If the text is changed to “Sensor error RH Supply air”, the following appears: 

 

 

Sensor error RH 

Supply air 

9 Sept 08:52 Class B 
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8.9 “Manual/Automatic” tab 

Most controller functions can be manually operated on this tab. This is useful mainly 
for testing purposes. 

 
 

Manual operation of functions causes alarms to be generated, which ensures that the 
control is reset to automatic mode. 

In this menu, all changes are downloaded directly into each connected controller. 
The “Load parameters” function is not required here. 

8.10 “System Configuration” tab 

 

 

 

 

 

 

 

 

 

 

 

 

 

This tab contains all the configuration parameters for the flexotron800. 

Since the contents of the tab are quite extensive, they are divided into sub-folders.  

You can go directly to the sub-folders using the list on the left side. 
 

 
For more information about the sub-folders, consult the relevant controller manual. 
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9 Expansion units 

One or two extension units can be connected to the flexotron800. A controller of type 
flexotron800 V2 is required for this purpose.  

Any flexotron800 model can be used as an extension unit. However, a flexotron800 
without a display is preferable because nothing is shown on the display of the 
extension unit.  

Either “Extension unit 1” or “Extension unit 2” can be selected under Applications in 
the controller. 

After the extension units have been put into service and the program has been 
configured, all flexotron800 units are connected. To download the configuration, the 
main controller is then connected to the computer through the selected port. The 
controller’s configuration corresponds to the description in section 8. 
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10 Updating of flexotron800 

CASE flexotron should always be updated with the latest program version. If the 
latest version of CASE flexotron is connected with a flexotron800 controller with an 
older version of the program, CASE flexotron displays two warnings.  

An alternative is to temporarily downgrade CASE flexotron to the version of the 
controller. All controller settings are retained, and the controller keeps its software 
version. 

The second alternative is to adapt the controller to the CASE flexotron version. This 
causes the flexotron800 to be temporarily taken out of service. Previous settings are 
permanently deleted. 

 

If the following steps are carried out, a new configuration is required. 

1. Start CASE flexotron and connect to the controller.  

►When prompted, downgrade the version of CASE flexotron to the controller 
version. 

 

2. In the “Settings” menu, select Synchronise all parameters.  

3. Then choose Update Tool  

► CASE flexotron should now have an exact copy of the controller 
configuration. 

4. Use Save as to save the configuration under an appropriate name. 

5. Close CASE flexotron. 

6. Reopen CASE flexotron.  

7. Choose the option of loading the controller with a new version. 

► The controller is reloaded 

8. Open the saved configuration file 
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9. Synchronise all the parameters and choose Update Controller.  

 
 
► The controller should now have the latest version and can be configured 
as before the upgrade.  

10. Make sure the parameter settings not available in the previous version have 
the correct values. 
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11 TCP/IP network terms 

11.1 Networks, subnets and routers 

IP network  An IP network is a cluster of cables and devices in which devices with IP addresses 
can communicate with any other device with a different IP address. The internet is a 
network, and when a computer is connected to the internet, it becomes part of the 
internet. 

Subnet  The networks are divided into subnets, which are, in turn, connected with routers. 
The routers need a map of the network (or at least the nearest subnets) and an 
address in order to send the information. A computer requires only the address of 
the nearest router. A locally connected Ethernet network is a subnet. Routers can 
have multiple Ethernet interfaces for different Ethernet networks, or an Ethernet 
interface and an ADSL connection.  

11.2 IP address, subnet mask, default gateway, DNS server 

IP address  Every computer or network-attached controller has an IP address consisting of four 
numbers between 0 and 255, with a total of 32 bits. 

Subnet mask  Every computer or controller attached to a network also has a subnet mask with 32 
bits. 

  Example: If the IP address is 192.0.2.73 and the subnet mask is 255.255.255.0, the 
subnet addresses range from 192.0.2.0 to 192.0.2.255. 192.0.2.73 is the address of 
your subnet. The subnet mask is sometimes determined by the number of bits used 
(it always starts at the beginning of the subnet mask). The subnet is then 
192.0.2.0/24, and the IP address and subnet mask can be specified together: 
192.02.73/24. 

Default gateway  Every computer and every controller that uses TCP/IP communication must know 
the IP address for the router that goes out from the subnet. The IP address of the 
router is usually called the default gateway. All information sent from the local 
subnet is sent to the default gateway. 

DNS name  The computer or the controller must know the device address with which it is 
connected. This information can be given as an IP address or DNS name. DNS is a 
function that can convert hierarchical names such as masterrechner.sauter-
controls.com into an IP address. Multiple DNS servers are part of a system, but 
only the IP address of one server needs to be known.  

IP configuration, 

brief summary 

 A complete IP configuration includes the IP address of the computer, the subnet 
mask, the IP address, the nearest router (also known as the default gateway) and a 
DNS server. 

11.3 DHCP, static and dynamic addresses 

Static and 
dynamic 

 If the IP settings were manually configured in a device, this is referred to as a static 
IP address; if the IP address was automatically assigned by a DHCP server on the 
subnet, it is a dynamic IP address.  

Dynamic IP 
address 

 Using dynamic addresses is a problem when other devices try to connect to the 
device, because the dynamic addresses are not known in advance and are subject 
to change. To be able to establish connections to devices with dynamic IP 
addresses, the device at hand must use DNS, which needs to be updated if the 
dynamic address changes via DHCP. This is commonly used in corporate networks 
and Windows computers. However, most internet service providers and many 
controllers do not support updating via DHCP and thus need to use a static IP 
address.  
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11.4 Internal and public addresses 

Internal 
addresses 

 There is a shortage of IP addresses on the internet. For this reason, organisations 
are asked to use internal IP addresses on the intranet. Several companies can use 
the same address, since the internal workstations do not connect with each other. 
This type of addressing is called internal addressing.  

Reserved 
addresses 

 The following addresses are reserved for internal networks:  

192.168.0.0 - 192.168.255.255 

172.16.0.0 - 172.31.255.255 

10.0.0.0 - 10.255.255.255 

See also: RFC1918, Address Allocation for Private Internets [Online document], 
[cited Nov 29 2005], available at http://www.ietf.org/rfc/rfc1918.txt 

Public 
addresses 

 Unique addresses on the internet are called public addresses. Further information 
on the use of IP addresses can be found under RFC3330, Special use, IPv4 
addresses, http://www.ietf.org/rfc/rfc3330.txt. 

NAT  During internet retrieval, firewalls can function as agents with computers with 
internal IP address. The connection from a computer with an internal IP address is 
converted into a connection from the firewall (with a public IP address) to the 
internet server. The information retrieved from the internet server is sent back to the 
firewall, which forwards it to the computer with an internal IP address. This process 
is called NAT (Network Address Translation) or IP masking. 

NAT router  A NAT router can also forward information from the public network to a computer on 
the internal network. For this, a special TCP or UDP interface forwards the 
information to an IP address on the internal network. 

11.5 Tunnel 

Two internal 
networks 

 Another way of enabling a connection via the internet from a workstation to a host 
computer on a corporate network with internal IP addresses to use a tunnel in the 
network. A tunnel means connecting two networks via the internet using internal IP 
addresses. For this purpose, all network packets to the destination network are 
encrypted (encryption of IP addresses and other information). The encryption is 
carried out by a network firewall. A new “address label” with the public addresses of 
the other firewalls is assigned to the packet. This firewall decrypts the content and 
forwards it to the target workstation in the corresponding network. Decryption 
requires that the password be known to all recipients. This technology is also known 
as VPN. 

PC internal 
network 

 A tunnel can also be created between an individual computer and an internal 
network. When employee are travelling on business, they often to first connect their 
laptop via GPRS and internet, and then connect to the corporate network using a 
tunnel. In the same way, technicians on standby duty can connect to the 
workstation from home or from the service vehicle and so on. 

http://www.ietf.org/rfc/rfc1918.txt
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12 flexotron800 with TCP 

  

 
The terms used here are explained in section 11. 

 

12.1 Connection 

The controller must be connected to a static, public IP address. The following 
connection methods were tested for flexotron800 with TCP:  

 Direct connection to an ADSL/cable modem 

 Connection to a router, which, in turn, is connected to an ADSL/cable 
modem 

 

 
flexotron800 with TCP has not yet been tested with all internet service providers. 

If the flexotron800 is connected behind a router with a built-in firewall, the router must 
be configured.  

The router should have a fixed public IP address.  

The controller must be found by the router, either by sending the IP address to the 
controller or by specifying the MAC address of the flexotron800. 

All incoming traffic on ports 80 and 26486 should be routed with NAT to the 
flexotron800 internal IP address.  

 
Additional information can be found in the router manual. 

Ports 80 and 26486 on the internet modem thus have to be open for inbound data 
traffic. 

This web server technology is built into the flexotron800 and is based on the web 
server integrated in the flexotron800. 

With a NAT connection, you can connect to more than one web server with a single 
white IP address. 

A flexotron800 can handle up to five connections from CASE flexotron and Internet 
Explorer simultaneously. 
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12.2 Two or more flexotron800 with TCP units through a single router 

You can connect to two or more flexotron800 with TCP units through one router if the 
communication routes are defined in the router. 

This is called port forwarding or NAT connection. In this method, the router knows 
which black IP address (LAN) it should connect to through the different WAN ports. 

For the second flexotron800, the communication interface must be set to “EXOline”.  

This setting is made under “Configuration -> System”. 

Website. 

For example, your have the possibility of setting the port to 26486 instead of 26000.  

 

 
 
 
 
 
 

Then call up “Tools -> Load website to the controller” to load the new setting onto the 
unit. If a third flexotron800 is used, it can be configured so that it is connected to 
EXOline via port 26001, for example. 
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The following figure shows the communication routes in a router for which the NAT 
connection was set to two flexotron800 units. The same scheme also applies when 
3, 4, 5 or more units of the flexotron800 are used. 

 
 
 
 
 
 

 

For example, if you want to access the unit with the black IP address 192.168.0.30, 
in the address field of the web browser of the client computer you need to enter the 
white IP address or DNS of the router, followed by “81”. 

Then the web server in flexotron800 sends the information on the layout of the 
website back to the client computer (via the same NAT connection). A Java 
application is also opened on the client computer, which controls EXOline 

communication, among other things.

White IP 
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The router settings in the example may differ depending on the manufacturer. See 
the example below for guidance. 
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12.3 Web server configuration 

As before, all configuration of the controller parameters is done through CASE 
flexotron or directly on the display. 

 

 
Configuration cannot take place via the web server. 

 

 
Information on configuring the controller can be found in the previous sections of 
this manual or in the corresponding manuals for flexotron800 Heating and 
Ventilation. 

 

If the configuration of the controller parameters is changed, the website is 
automatically downloaded to the web server. If the website settings have been 
changed, it is only necessary to update the website.  

 
TCP/IP interface configuration 

The TCP/IP interface is configured in the flexotron800 via the “Settings” -> 
“Communication Settings” menu item. 

1. Select “Use TCP/IP interface in this controller” 

2. When prompted, select the “right cable” 

3. Use the search function to find the correct controller 

4. Once the correct controller has been found, confirm the selection with [OK] 

5. Press the [TCP/IP, WEBsite and e-mail settings] button 

► The following input window opens 
 

“TCP/IP, WEBsite and e-mail settings” input window 

 
In this window, the following settings can be made:  

 

IP settings  Here you select whether the flexotron800 is to have a static IP address or the 
DHCP server is to assign a dynamic IP address. 

If the TCP/IP interface has a fixed IP and an e-mail server is specified with the help 
of the network name, a DNS server must also be specified under “Use the following 
IP Settings”. The TCP/IP interface can then convert the network name into an IP 
address. If DHCP is used, this happens automatically. 

DNS name  The flexotron800 can be associated with a DNS name, such as DNS name: 
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Flexotronweb, domain: sauter-controls.com. The IP address of the controller is then 
associated with the DNS name flexotronweb.sauter-controls.com. 

Encrypted 
communication 

 The encryption is intended to prevent other users in the TCP/IP network from 
connecting with the flexotron800 via CASE flexotron. 

The password is used only to connect the flexotron800 via CASE flexotron. If the 
password is lost, the settings must be cleared and the controller reloaded.  

Web user login 
passwords 

 Passwords for logging into the website. Guests can view all the values. Operators 
(users) can view and modify values. The service has no function through the web 
and instead functions as an operator. 

E-mail server 
network settings 

 Network address for the e-mail server 
The outgoing SMTP e-mail server with which the TCP/IP interface e-mails are to be 
sent is specified here. Either as the network name (DNS name, such as 
smtp.exampledomain.com) or as an IP address.  

An IP address is usually assigned within local networks. When there is a connection 
to the internet, network names are more common. Which e-mail server is to be 
specified can be obtained from the network technician or internet service provider. 

Note: The specified network name must be directly associated with the e-mail 
server. It cannot be an alias or another network name. To check whether you have 
a directly associated network name, proceed as follows: 

1. Use the Windows command prompt (“Start Menu” > “All Programs” > 
“Accessories” > “Command Prompt” to execute the ping command on the 
network name (e.g. ping smtp.exampledomain.com).  

2. Here you check whether the command “Pinging smtp.exampledomain.com” 
receives a response. 

Login Name and Login Password 
These two fields are used only if the outgoing e-mail server requires a login and 
supports the AUTH LOGIN method. Otherwise, this field does not need to be 
completed.  
Other login methods or encodings are not currently supported. 

E-mail sender 
address 

 The address that is to serve as the sender in the e-mail is specified here. Many e-
mail servers and junk mail filters require a real e-mail address here. Otherwise, a 
fictitious sender address can be specified, e.g. MyController@MyDomain.com. If 
you are unsure about what to enter, ask your network technician. 

Setting up 
TCP/IP settings 

 After the settings described above have been performed, you download the settings 
to the TCP/IP card in the controller by clicking this box. 
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12.4 Website settings 

In the “System -> Website” sub-folder and “E-mail” in the Configuration folder, the 
following settings can be made for the website: 

 

Website 
heading 

 Here you can select a heading that appears on the first page when visitors surf the 
flexotron800 website.  

 

Link, heading  Up to four different links to small PDF files or other internet sites can be added to the 
website.  

Note: The total size of the PDF files and the process image should not exceed 150 
kB. Under Link1, heading, enter the heading for Link 1; under Link2, heading, the 
heading for Link 2, etc.  

The heading must not contain any spaces. For example, for Fr Sauter, you must enter 
Fr_Sauter. That is the default setting for heading 4. 

 

Process image  The selected image is displayed in the heading on the web. Due to the low storage 
capacity, the image should be in .jpg format or similar. 

 

E-mail  The e-mail address to which the alert is to be sent, the title and the subject of the 
message must be specified here. 

 

After you have made all the above settings and downloaded them to the TCP/IP 
card, all you need to do is download the settings to the web server in the 
flexotron800. This is done with the Settings / Load website to controller command. 
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12.5 Logging into the website 

The following image shows the login page for the flexotron800. 

 
Log in by entering the password specified under “TCP/IP -> WEBsite and e-mail 
settings”. 

12.6 Changing values on the website 

 

 

 

 

 

 

 

All values in blue can be changed. 

Once a value has been changed and confirmed with Enter, the value is downloaded 
to the flexotron800.  

Real-time trend charts in flexotron800 with TCP 

This feature allows real-time trend charts to be managed directly on the website. 

You can use the “Copy to clipboard” command to copy the currently displayed values 
into the chart (as tab-delimited text, “TSV”). This text can then be copied to an Excel 
file, for example. 

If the “Copy to clipboard” command is executed, a dialogue box opens in which the 
granularity of the values to be copiedcan be selected.  

The following options are available:  

 1 hour 

 15 minutes 

 1 minute 

 5 seconds 
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The most suitable alternative is pre-selected, taking into account the current interval. 

 

 

 

 

 

 

 

 

 

During the copying process, a title line is first created. Then a line is generated for 
each period duration (based on the selected granularity) for the time range displayed 
in the chart, along with the signals. 

 The title line consists of a date, followed by the names of the different 
signals, including the units (in parentheses). 

 The additional lines consist of a time that the values for the different signals 
follow (with the configured number of decimal places, but without units). 

 

Date and time specifications and decimal symbols are displayed in country-specific 
format and according to the settings of the computer on which the web browser is 
running. 

 

For time periods for which there are no values (or these values are not applicable), 
an empty string is displayed for the value. 

 
Example: 

01 jul 2014 Room 
temperature (°C) 

Room 
setpoint (°C) 

Supply air fan 
pressure (Pa) 

Return air fan 
pressure (Pa) 

10:28:00     

10:29:00 23.1 23.0 87 86 

10:30:00 23.1 23.0 85 87 

10:31:00 23.1 23.0 87 85 

10:32:00 23.1 23.0 85 86 

10:33:00 23.0 23.0 87 86 

10:34:00 23.1 23.0 88 86 

10:35:00 23.1 23.0 89 86 

10:36:00 23.0 23.0 86 85 
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